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Introduction
Welcome to FastAddressClient, the most powerful and simplest to use address and data capture tool
on the market.

FastAddressClient provides an easy method for capturing addresses from an incomplete address or
postcode. This greatly speeds up the process of capturing addresses while at the same time ensuring
that accurate address information is stored.

FastAddressClient can also return details, keys and codes associated with an address.
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1. Sign in to the AddressServer
Sign in to the AddressServer

Figure 1.1. The sign in window

Sign In

1. Click the Settings menu then click the Sign In menu item.

2. In the Sign In dialog, configure the AddressServer protocols and hosts, and enter your username
and password.

3. Click the Sign In button.

4. Select the MAF you wish to use from the MAF list.

If you configure two hosts, reliability can be improved. FastAddressClient will automatically use the
second host if the first host becomes unavailable.

If you use https, FastAddressClient will verify root certification authorities against a 'cacert.pem' file.
On Windows, you don't need to do anything because FastAddressClient will generate this file auto-
matically from the Windows Certificate Store. On other platforms, you can set an environment vari-
able, HPW_CACERT, to specify the directory containing your cacert.pem file. If this environment
variable is not set, FastAddressClient will look in the current directory for the file. If you don't have
a cacert.pem file, you can obtain one here: https://curl.haxx.se/ca/cacert.pem

Note
Before using the AddressServer, you will have to sign up for an account.
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2. Address Search
Click on the Address Search icon to switch to Address search mode.

Figure 2.1. The Address Search Window

1. Type a partial address or postcode into the Search text box and then press Enter or click the Search
button.

2. A list of possible matches will be returned if more than one match is found. Select the correct
address from the Possible Matches list.

3. A complete address will be displayed in the Completed Address text box.

4. Click the Copy button to copy the selected address label to the clipboard. The address label can
then be pasted into another application.

5. FastAddressClient will return other fields related to the address. These fields can be viewed by
clicking the View button. Please note that these fields will not be copied to the clipboard.

Sample inputs include:

1. high s*, altrin*

2. 10 Downing St, London

3. 10, SW1A 2AA

4. 10 Downing St

5. SW1A 2AA
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3. AutoComplete Search
Click on the AutoComplete icon to switch to AutoComplete mode.

Figure 3.1. The AutoComplete Search Window

1. The AutoComplete search lists the possible matches as you type.

2. The minimum search length is set in the Minimum Length dropdown listbox. This defines how
many characters have to be entered before the search begins.

3. A list of possible matches will be returned if more than one match is found. Select the correct
address from the Possible Matches list.

4. A complete address will be displayed in the Completed Address text box.

5. Click the Copy button to copy the selected address label to the clipboard. The address label can
then be pasted into another application.

6. Click the Send button to send the selected address label to the application window that has been
set in the Send address fields to another application section.

7. FastAddressClient will return other fields related to the address. These fields can be viewed by
clicking the View button. Please note that these fields will not be copied to the clipboard.

AutoComplete icon will be disabled if the Server, that FastAddressClient is connecting to, is not
running the AutoComplete service.
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Figure 3.2. Address server without AutoComplete service

An information Window will be displayed if the MAF doesn't support AutoComplete. This will allow
the user to switch to the required MAF or continue in Address search mode.

Figure 3.3. Select AutoComplete MAF

Sample inputs include:

1. hopewi

2. high

3. wa14

4. Manch

5. birmin
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4. Name Search
Figure 4.1. The Name SearchWindow

1. Name searching is available when you have purchased a MAF with names data.

2. Click the Layout menu, click the Screen Layout option, then select either Classic Names or Mul-
ti-Field Names.

3. Type Surname, Forename, and a partial address to limit the matches into the appropriate text
boxes then press Enter or click the Search button.

4. A list of possible matches will be returned if more than one match is found.

5. Click the Layout menu, then select Middle Name/Initial Search to search on middle names or
initials.

Note
When a search involves a name, the premise is ignored.
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5. Change matching options
The address matching and presentation rules can be tailored to suit your needs.

Change matching options

1. Click the Setup icon in the Toolbar to show the wizard.

2. Click the Matching Options link in the left panel.

3. Edit the matching options to suit your needs.

Note
When in AutoComplete mode the Advanced options can't be modified.

Figure 5.1. The matching options window

Table 5.1. Options Explained

Field Name Description

Return valid house Return the valid house name and discard the vanity house name
from the address label.

Return valid district Return the valid district and discard the vanity district from the
address label.

Label format Select how the address lines in the output label should be posi-
tioned. Standard: Remove empty address line; Fixed Postcode:
reserves the final field for postcode; Fixed town: reserves the last
3 fields for town, county and postcode.

Reserve Organisation line Select whether the top line in the address label is reserved for the
organisation name.
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Field Name Description

Include county Select whether the county should be included in the address label.

Drop county to fit label Select whether the county should be omitted to fit the address la-
bel within the given space.

Town format Select the casing of the town field as displayed in the address la-
bel.

Combine house and flat to
premise

In the possible match list, if there are more than one sub-premises
(e.g. multiple companies, flats or floors) they are separated into a
new address field of the list. otherwise the possible match list will
combine all of the sub-premises with premise in the same address
line.

Display results Select how to display the results, either in tree format or in list
format.

Display list level Select whether name details are displayed individually or as ex-
pandable items associated with an address (only for datasets with
name information).

Result sorting Select whether the address list is presented in premise, street,
town order or in postcode order.

Result formatting Specify whether the premise level matches should include street
and town information when in tree mode.

Streets over multiple districts When a street which spans several district is expanded, each dis-
trict is first displayed as node which can then be expanded. If sep-
arated is not set, all items for the street across all districts will be
displayed at the next address line.

Subpremise level When in tree mode, specify whether Sub-premises are displayed
on a new address line or combined with premise.

Include county in possible
matches list

Specify if counties should be included within the matched ad-
dresses.

Return Welsh addresses Select to return Welsh versions of addresses if available.

Postcode in possible matches
list

Select to include the postcode in the possible matches list.

Lookup result level Select whether the possible matched list is displayed at street lev-
el, expandable to include premise, or displayed at premise level.

Maximum match count Select the maximum number of items to return.

Timeout seconds Request timeout in seconds.

Name lookup timeout seconds Name lookup request timeout in seconds.

Note
Name searching is only available when you have purchased a MAF with names data. In
the Matching Options table, the Drop name from label option will only appear when
the purchased MAF contains name data.



8

6. Send address fields to another
application

FastAddressClient has a powerful set of features to send an address label and other address fields to
another application.

Figure 6.1. The sendkeys window

Before using these features, you should set up the behaviour you want.

Steps to configure send keys

1. Select the target window.

2. Set the target window options.

3. Select the output fields.

4. Record the keystrokes.

5. Set the sending options.

6. Change the copy button text.

The features are all set in pages within a wizard. Click the Setup icon in the Toolbar to show the
wizard.

A wizard page can be selected by clicking on the name in the left panel of the wizard or by pressing
CTRL-up or CTRL-down.

6.1. Select target window
1. Click the Select Target Window link in the left panel.
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2. Click the By Title button to select the target window by its title.

3. Select the window you want to send the address fields to by double-clicking the name of the window
in the list or by selecting the window in the list and then pressing the Use Selection button.

4. A target window can also be selected by dragging and dropping the Aim button onto the target
window.

5. Click the Refresh List button to update the target window list.

6. Click the By Z-Order button to select the target window by its Z order.

6.2. Target window options
1. Click the Target Window Options link in the left panel.

2. Highlight the window to send the address to.

3. Click the Configure Target Application Start-up... button if you want the target application to
be started each time an address is sent to it.

4. When the Configure Target Application Start-up... button is clicked enter the path to the
application's executable file and enter the command line arguments if necessary.

5. Sendkeys uses the window title to identify the target window. However, the target window title
name may change. It is possible to use a wildcard in the target window title by clicking the Edit
button.

6.3. Select output fields
Select and unselect the fields to be sent to the target window.

1. Click the Select Output Fields link in the left panel.

2. Select fields by highlighting them in the Available Fields list then click the Add button.

3. Fields are reordered by clicking the up and down buttons.

4. Fields are unselected by highlighting them in the Selected Fields list and clicking the Remove
button.

Table 6.1. Output Fields

Field Name Description

Label 1 The first line of a formatted address label

Label 2 The second line of a formatted address label

Label 3 The third line of a formatted address label

Label 4 The fourth line of a formatted address label

Label 5 The fifth line of a formatted address label

Label 6 The sixth line of a formatted address label

Label 7 The seventh line of a formatted address label

Label 8 The eighth line of a formatted address label

Label 9 The ninth line of a formatted address label

Department The department within an organisation

Organisation The organisation name
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Field Name Description

Flat Formatted sub-premise information

Floor A level with a building

PO Box The PO Box

House Name 1 House name information

House Name 2 House name information

Premise The premise number range

Street Name 1 The thoroughfare name

Street Name 2 The second thoroughfare name (if the address
has one)

District Name 1 The district name

District Name 2 The second district name (if the address has one)

Town The town name

County The county name

Postcode The postcode

DPS The delivery point suffix

Country The country

UDPRN The UDPRN

UAID The unique address identifier

Dedupe Key The deduplication key

Extended Dedupe Key The extended deduplication key

6.4. Record keystrokes
It may be necessary to add extra keystrokes, such as tabs, when sending an address so that the address
fields are sent to the correct fields within the target window.

1. Click the Record keystrokes link in the left panel.

2. Extra keystrokes can be added before and after a field is sent.

3. To record a keystroke, click on a cell then click the Edit/Record Keys... button.

4. A window will open and the keystrokes will be recorded. Click the OK button when finished.

6.5. Sending options
Select what should happen after an address has been sent to the target application.

1. Click the Sending Options link in the left panel.

2. Select the combination of options that best suits your needs.

3. Click the Test Sending button to test that the settings behave as expected.

4. You may have to change the Send Method if the test failed to send fields to the target application.
To change the Send Method click the Advanced button and select a different method.

5. Click the Reset button to reset the options back to their default values.

6.6. Change copy button text
1. Select the Home icon in the Toolbar
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2. The Copy button should be changed to display either Send or Copy and Send.

3. Click the Send button after an address has been captured to send the address fields to the target
application.
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7. Load and save setup files
The matching options and send keys settings can be saved to and loaded from a setup file.

1. Click the File menu then click the Save or Save As... menu item to save the settings to a file.

2. Click the File menu then click the Load menu item to load the settings from a file.

Change setup file directory

1. Click the Settings menu then select the Preferences menu item.

2. In the Preferences window, browse to the directory where your setup files are located.
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8. Layout Options
The layout of the application can be altered to suit your taste.

The following layouts can be selected:

1. Classic

2. Multi-Line

3. Single Line

4. Multi-Field

5. Compact

6. Classic Names

7. Multi-Field Names

Click the Layout menu, then click the Screen Layout menu and select a layout.

After capturing an address, the keyboard focus will automatically move to the Copy button. To prevent
the focus from moving, uncheck the Focus on copy button menu item.

Click the Layout menu, then click the Search History menu, to turn on the search history. The last
ten search strings will be remembered and recalled when using Classic layout, Single Line layout,
Compact layout or Classic Names layout.

Click the Layout menu, then click the Middle Name/Initial Search menu to turn on middle name
searching. Middle name search is available in Classic Names layout and Multi-Field Name layout.
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9. Run from the command line
Table 9.1. Command line options

Option Description

-s --setup=<str> The setup filename.

-l --lookup=<str> Do an address lookup.

-o --hostname=<str> The AddressServer hostname.

-o2 --hostname2=<str> The second AddressServer hostname.

-u --user=<str> Your AddressServer username.

-p --password=<str> Your AddressServer password.

--no-soap-service=<str> Don't attempt to connect to the SOAP service for
a list of available MAFs.

--layout=<str> Specify the layout: "Classic", "Multi-Line",
"Single Line", "Multi-Field" or "Compact".

--hide-setup Hide setup windows.

--dont-write-registry Do not write settings to the registry.

--dont-read-registry Do not read settings from the registry.

--dont-check-for-updates Do not check online for software updates.

--show-all-parameters Show all parameters.

-h --help Display help about the command line parame-
ters.
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Appendix A. Additional Licences

A.1. libcurl

Copyright (c) 1996 - 2008, Daniel Stenberg, <daniel@haxx.se>.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

    

A.2. Other software

hash.c: chained hash tables

Reference: Your favorite introductory book on algorithms

Copyright (C) 2000 Bjorn Reese and Daniel Veillard.

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.

Author: breese@users.sourceforge.net

    

list.c: lists handling implementation
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Copyright (C) 2000 Gary Pennington and Daniel Veillard.

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.

Author: Gary.Pennington@uk.sun.com

    

$Id: trio.c 3600 2007-04-17 12:44:58Z veillard $
$Id: trio.h 1886 2003-04-03 15:28:28Z veillard $

Copyright (C) 1998 Bjorn Reese and Daniel Stenberg.

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.

$Id: triodef.h 3473 2006-05-31 13:35:28Z veillard $
$Id: trionan.c 3790 2008-09-01 13:08:57Z veillard $
$Id: trionan.h 2026 2003-08-06 04:43:55Z wbrack $

Copyright (C) 2001 Bjorn Reese <breese@users.sourceforge.net>

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.

$Id: triop.h 1886 2003-04-03 15:28:28Z veillard $

Copyright (C) 2000 Bjorn Reese and Daniel Stenberg.

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.
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$Id: triostr.c 3600 2007-04-17 12:44:58Z veillard $
$Id: triostr.h 3600 2007-04-17 12:44:58Z veillard $

Copyright (C) 2001 Bjorn Reese and Daniel Stenberg.

Permission to use, copy, modify, and distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND
CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER.
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